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Documentation Updates
The title page of this document contains the following identifying information:
l

Software Version number, which indicates the software version.

l

Document Release Date, which changes each time the document is updated.

l

Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go
to:
http://h20230.www2.hp.com/selfsolve/manuals
This site requires that you register for an HP Passport and log on. To register for an HP Passport
ID, go to:
http://h20229.www2.hp.com/passport-registration.html
Or click the New users - please register link on the HP Passport log on page.
You will also receive updated or new editions if you subscribe to the appropriate product support
service. Contact your HP sales representative for details.
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Support
Visit the HP Software Support Online web site at:
http://www.hp.com/go/hpsoftwaresupport
This web site provides contact information and details about the products, services, and support
that HP Software offers.
HP Software online support provides customer self-solve capabilities. It provides a fast and
efficient way to access interactive technical support tools needed to manage your business. As a
valued support customer, you can benefit by using the support web site to:
l

Search for knowledge documents of interest

l

Submit and track support cases and enhancement requests

l

Download software patches

l

Manage support contracts

l

Look up HP support contacts

l

Review information about available services

l

Enter into discussions with other software customers

l

Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also
require a support contract. To register for an HP Passport ID, go to:
http://h20229.www2.hp.com/passport-registration.html
To find more information about access levels, go to:
http://h20230.www2.hp.com/new_access_levels.jsp

Page 4 of 49

HP SOA Systinet Workbench (4.03)

Taxonomy Editor User Guide

Disclaimer for PDF Version of Online Help
This document is a PDF version of the online help. This PDF file is provided so you can easily print
multiple topics from the help information or read the online help in PDF format.
Note: Some topics do not convert properly to PDF, causing format problems. Some elements of
online help are completely removed from the PDF version. Those problem topics can be
successfully printed from within the online help.
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About this Guide
Welcome to the Taxonomy Editor User Guide. This guide describes how to use Taxonomy Editor
as part of HP Systinet.
This guide contains the following chapters:
l

"Taxonomy Editor" (on page 9)
Provides an overview of the main features of Taxonomy Editor.

l

"Getting Started" (on page 18)
Describes the installation of the main features and shows you how to create a taxonomy project.

l

"Managing Taxonomies" (on page 26)
Explains how to create, download, edit, and compare taxonomies.

l

"Deploying Taxonomies" (on page 32)
Shows how to publish taxonomies and build and deploy a Taxonomy Extension.

l

"Conflicts and Validation Issues" (on page 37)
Shows how to resolve conflicts with taxonomies.

l

"Example: Creating and Publishing a Department Taxonomy" (on page 39)
A walkthrough example of creating and deploying a new taxonomy.

l

"Keyboard Shortcuts" (on page 40)
Keyboard shortcuts reference.

l

"Dialog Boxes Reference" (on page 42)
Dialog box reference.

l

"Troubleshooting" (on page 47)
Troubleshooting tips.

l

"Eclipse Plug-in Requirements" (on page 49)
Required plug-ins when installing Workbench as an update.
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Chapter 1
Taxonomy Editor
HP SOA Systinet Workbench is a set of Workbench features that enable you to manage
taxonomies in Systinet.
You can use Taxonomy Editor to create, modify, and delete taxonomies. You can also download
taxonomies from, or upload them to, any number of Systinet servers.
This chapter introduces Taxonomy Editor in the following sections:
l

"Workbench Suite" (on page 9)

l

"Overview" (on page 9)

l

"User Interface" (on page 10)

Workbench Suite
HP SOA Systinet Workbench is a suite of editor tools enabling you to customize your deployment
of Systinet.
Workbench consists of the following editor tools, distributed as a single Eclipse development
platform:
l

Customization Editor
Customizes the underlying SOA Definition Model (SDM) within Systinet.

l

Taxonomy Editor
Customizes the taxonomies used to categorize artifacts in Systinet.

l

Assertion Editor
Customizes the conditions applied by your business policies within Systinet.

l

Report Editor
Customizes report definitions for use with Systinet.

Overview
Taxonomies are, in their simplest form, a visual representation of what your organization actually
knows. A well-constructed, meaningful taxonomy enables users in your organization to quickly find
the information they need to achieve their goals.
Taxonomy Editor enables you to organize and reorganize content easily, giving more flexibility for
knowledge sharing in your organization
Use Taxonomy Editor to do the following:
1. Create a Taxonomy Project.
For details, see the following sections:
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n

"Creating a Taxonomy Project" (on page 21)

n

"Downloading Taxonomies from a Server" (on page 23)

n

"Searching for Taxonomies" (on page 23)

2. Create and Manage Taxonomies.
For details, see the following sections:
n

"Creating Taxonomies" (on page 26)

n

"Editing Taxonomies" (on page 26)

n

"Editing Categories" (on page 27)

n

"Deleting and Restoring Taxonomies" (on page 29)

n

"Comparing Taxonomy Files" (on page 30)

n

"Updating Taxonomies from the Server" (on page 30)

n

"Importing and Exporting Taxonomy Files" (on page 30)

3. Publish taxonomies to an Systinet server.
For details, see the following sections:
n

"Publishing Taxonomies" (on page 32)

n

"Deploying Taxonomies" (on page 32)

4. Check local validity and manage conflicts.
For details, see "Conflicts and Validation Issues" (on page 37).

User Interface
The default perspective is split into a number of sections, with menu options across the top, as
shown in the following screenshot.
Screenshot: Taxonomy Editor UI
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The platform perspective consists of the following views:
l

Project Explorer
The tree view of your taxonomy projects. For details, see "Project Explorer" (on page 11).

l

Server Explorer
The view listing Systinet server connections to the Workbench. For details, see "Server
Explorer" (on page 13).

l

Editor
The view showing the components of the taxonomy. For details, see "Editor View" (on page 14).

Project Explorer
Project Explorer contains a hierarchical list of projects, the taxonomies in each project, and the
categories and subcategories of each taxonomy, as shown in the following screenshot.
Screenshot: Project Explorer
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The Project Explorer contains additional context menu options enabling you to interact with a
running Systinet server. Right-click the project name or a particular assertion, and select HP
Systinet to view the options listed in the following tables.

Project Context Menu Options
Option

Function

Download
Taxonomies

Import taxonomies from Systinet. For details, see "Downloading Taxonomies from
a Server" (on page 23).

Upload to
Server

Export taxonomies to the default Systinet server. For details, see "Publishing
Taxonomies" (on page 32).

Update from Update taxonomies from Systinet. For details, see "Updating Taxonomies from
Server
the Server" (on page 30).
Remove
from Server

Delete taxonomies from Systinet. For details, see "Deleting and Restoring
Taxonomies" (on page 29).

Upload To
Other
Server

Export taxonomies to a specified Systinet server.

Build
Extension

Create a taxonomy extension for Systinet containing all the taxonomies in your
project. For details, see "Building a Taxonomy Extension" (on page 32).

Taxonomy Context Menu Options
Option

Function

Upload to Server Export a taxonomy to the default Systinet server. For details, see "Publishing
Taxonomies" (on page 32).
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Option

Function

Update from
Server

Update a taxonomy from Systinet. For details, see "Updating Taxonomies
from the Server" (on page 30).

Remove from
Server

Delete the taxonomy from Systinet. For details, see "Deleting and Restoring
Taxonomies" (on page 29).

Upload To Other
Server

Export a taxonomy to a specified Systinet server.

Validate Data
Consistency

Check the validity of the taxonomies. For details, see "Conflicts and
Validation Issues" (on page 37).

Show
Taxonomy
Usage

Find the artifacts that use the taxonomy for categorization. For details, see
"Conflicts and Validation Issues" (on page 37).

Compare With
Latest From
Server

Compares the selected taxonomy with the latest version on the server.

Build Extension

Create a taxonomy extension for Systinet containing all the taxonomies in
your project. For details, see "Building a Taxonomy Extension" (on page 32).

Server Explorer
The Server Explorer displays the Systinet servers connected to Workbench, as shown the
following screenshot. The functionality is shared by all the Workbench editors.
Screenshot: Server Explorer View

Right-click a server in the Server Explorer to open the context menu described in the following
table.

Server Explorer Context Menu Options
Option

Function

New Server

Add a server for downloading assertions and taxonomies (Assertion Editor,
Taxonomy Editor, and Customization Editor).

Remove
Server

Delete a server from the Server Explorer.
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Option

Function

Download
Taxonomy

Download a taxonomy from a server (Taxonomy Editor and Customization
Editor).

Download
Assertion

Download assertions from a platform server (Assertion Editor).

Download
Report

Download reports from a reporting server (Report Editor).

Properties

View and edit the server name, URL, username, and password.

Editor View
The Editor pane is the main feature of the Taxonomy Editor UI.
It has four tabs, described in the following sections:
l

Overview Tab
The Overview tab shows the components of the taxonomy.

The first section is General Information, where you can view and edit the following properties:
n

Name
Name for the taxonomy. The content of the name element in the taxonomy's XML
representation.

n

Taxonomy ID
Identifier for the taxonomy, with the preceding uddi:. The value of tModelKey attribute in
the taxonomy's XML representation.

n

Description
Description of the taxonomy (optional).

The second section is Origin, which shows:
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n

Resource URL
REST interface URL enabling the published taxonomy to be viewed on the server.

n

Value Display Format
These options allow changing how the value is presented.

l

Categories Tab
The Categories tab enables you to change the structure and properties of taxonomy categories.

You can use the Categories tab to do the following:

l

n

"Adding a Category" (on page 28)

n

"Removing a Category" (on page 28)

n

"Copying a Category" (on page 28)

n

"Moving a Category" (on page 29)

Advanced Tab
The Advanced tab enables you to set properties used with UDDI.

It is divided into the following sections:
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n

Compatibility
Enables you to select one or more of the main UDDI structures for the taxonomy. For
example, businessEntity, businessService, bindingTemplate, and tModel.
All structure types are selected by default which is the required setting if you want your
taxonomy to integrate with UDDI Registry.

n

Categorization
Enables you to select from the following taxonomy types:
o

categorization
Tags the UDDI structure with additional information, such as identity, location, and
description.

o

categorizationGroup
Groups several categorizations into one logical category. For example, a
categorizationGroup could be a geographical location comprised of two
categorizations: longitude and latitude.
The categorizationGroup option is disabled if the taxonomy has any categories.

o

Identifiers
Reference published information in businessEntities and tModels.

o

Relationships
Defines the relationship between two businessEntities in Publisher Assertions.

n

Validation
Sets whether or not the values in keyedReferences within the taxonomy are checked. The
validation service can check the expected syntax of values. For example, a credit card
number or an ISBN number.
Validation can be against Taxonomy Editor's internal validation service or against an external
service.
To select an external validation service, do one of the following:

n

o

Enter the endpoint URL.

o

Leave keyedReferences unvalidated.

Reference
Enables you to add a reference to a key type.

n

Value Type
Enables you to Select a Value type for keyValues, using one of the following comparators:
o

systinet-com.comparator.string
keyValues are treated as string values. The maximum length is 255 characters.
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o

systinet-com.comparator.numeric
keyValues are treated as decimal numbers. The value can have a maximum of 19 digits
before the decimal point and a maximum of 6 digits after the decimal point.

o

systinet-com.comparator.date
keyValues are treated as dates.

o

custom
Endpoint URL of a custom comparator.

l

Source Tab
The Source tab enables you to view and directly edit the XML representation of the taxonomy.
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Getting Started
This chapter describes the prerequisites for working with taxonomies in Taxonomy Editor. It
contains the following sections:
l

"Installing Workbench" (on page 18)

l

"SSL Configuration" (on page 21)

l

"Customizing Taxonomy Editor" (on page 22)

l

"Creating a Taxonomy Project" (on page 21)

l

"Downloading Taxonomies from a Server" (on page 23)

l

"Searching for Taxonomies" (on page 23)

Installing Workbench
SOA Systinet Workbench is an Eclipse development platform distributed as a zip file, hp-soasystinet-workbench-4.0n-win32.zip or as a plugin for an existing Eclipse environment,
hp-soa-systinet-workbench-4.0n-plugin.zip.
Note: For supported platforms and known issues, see readme.txt alongside the archive.
Note: SOA Systinet Workbench requires Java SE Development Kit (JDK) 1.6.0 (32 bit version
only) or higher. You must include the path to this version of the JDK in the JAVA_HOME
environment variable.
To install SOA Systinet Workbench as a new Eclipse platform:
l

Extract the archive to your required location, referred to in this document as WB_HOME.
Note: The path must not be longer than 97 characters.

To install SOA Systinet Workbench to an existing Eclipse platform:
1. Ensure that your Eclipse platform contains the necessary plug-ins. For details, see "Eclipse
Plug-in Requirements " (on page 1).
2. In your current Eclipse SDK (3.3 or later), use the software updates feature to install SOA
Systinet Workbench.
Select Help>Software Updates>Find and Install....
The Install/Update dialog opens.
3. In the Install/Update dialog, select Search for new features to install, and click Next.
The Install – Update Sites to Visit dialog opens.
4. In the Update Sites to Visit dialog, click New Archived Site.
The Select Local Archive Site dialog opens.
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5. Locate and select hp-soa-systinet-workbench-4.0n-plugin.zip, and then click
Open.
The Edit Local Site dialog opens.
6. In the Edit Local Site dialog, if required, rename the local archive name, and click OK.
7. In the Install – Update Sites to Visit dialog, select the new local archive, and then click Finish.
The Updates – Search Results dialog opens.
8. Select the modules from the archive that you want to install:
n

Workbench Extra 4.0n
SOA Systinet Workbench splash screen.

n

Taxonomy Editor 4.0n
Note: Required for Customization Editor.

n

Customization Editor 4.0n

n

Assertion Editor 4.0n

n

Report Editor 4.0n

n

Common Plugin 4.0n
Shared components used by the editors.

Click Next.
The Install – Feature License dialog opens.
9. In the Feature License dialog, select I accept the terms in the license agreements, and
click Next.
The Install – Installation dialog opens.
10. In the Installation dialog, if required, change the installation location, and then click Finish.
11. If you install Workbench Extra 4.0n make the following configuration changes:
n

Remove -showsplash org.eclipse.platform from ECLIPSE_
HOME/eclipse.ini.

n

Edit ECLIPSE_HOME/configuration/config.ini and make the following changes:
o

Set
osgi.splashPath=platform:/base/plugins/com.systinet.tools.workbench
.

o

Set eclipse.product=com.systinet.tools.workbench.ide

To Start SOA Systinet Workbench:
l

Execute WB_HOME/workbench/start.exe.

The first time you start Workbench, the welcome screen opens.
Screenshot: Workbench Welcome Screen
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Select one of the options to open one of the editor tools, start a new editing project, or view the
documentation set.
You can return to the welcome screen from any of the editor tools by selecting Help>Welcome
from the menu options.
By default, Workbench runs in 'normal' mode which prevents users from uploading system
taxonomies (IDs start with uddi:systinet.com:soa:model:taxonomies) and the Report
Editor .rptlibrary file to Systinet servers. If you need to work with system taxonomies or want
to upload the .rptlibrary file you can switch Workbench into 'admin' mode.
Caution: Be extremely careful when working with system taxonomies, Systinet uses some hardcoded values from system taxonomies, changing or removing them may cause errors.
To Switch Workbench to Admin Mode
1. Open WB_HOME/configuration/config.ini with a text editor.
2. Add mode=admin to config.ini.
3. Restart Workbench.
Tip: SOA Systinet Workbench is memory-intensive. If you experience performance issues, HP
recommends increasing the memory allocation.
To increase the memory allocation for SOA Systinet Workbench:
1. Open WB_HOME/workbench/start.ini for editing.
2. Set these new values:
n

-Xms128m

n

-Xmx1024m

3. Save your changes.
4. Restart Workbench.
Tip: SOA Systinet Workbench downloads from Systinet may time out. If you experience issues,
HP recommends increasing the time out.
To increase the time out for SOA Systinet Workbench:
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1. Open WB_HOME/workbench/start.ini (or eclipse.ini for stand-alone installation) for
editing.
2. Set the new value:
-Dorg.systinet.platform.rest.Client.timeout=200000
The value is in milliseconds with a default value of 120000 (2 minutes).
3. Save your changes.
4. Restart Workbench.

SSL Configuration
By default, Workbench trusts all Systinet server certificates. You may want Workbench to verify
Systinet certificates.
To Verify Systinet Server Certificates:
l

Add the following options to WB_HOME/workbench/start.ini:
-Dcom.hp.systinet.security.ssl.verifyCert=true
-Djavax.net.ssl.trustStore=USER_TRUSTSTORE
-Djavax.net.ssl.trustStorePassword=TRUSTSTORE_PASS
-Djavax.net.ssl.trustStoreType=TRUSTSTORE_FORMAT

If Systinet is configured for 2-way SSL, you must provide Workbench certificates to Systinet.
To Provide Workbench Client Certificates to Systinet:
l

Add the following options to WB_HOME/workbench/start.ini:
-Djavax.net.ssl.keyStore=USER_KEYSTORE
-Djavax.net.ssl.keyStorePassword=KEYSTORE_PASS
-Djavax.net.ssl.keyStoreType=KEYSTORE_FORMAT

Creating a Taxonomy Project
To work with taxonomies, you need a Taxonomy Project. You can create any number of Taxonomy
Projects to help organize your work.
To Create a Taxonomy Project:
1. Do one of the following:
n

In the Workbench Welcome page, click Create Taxonomy Project.

n

Click New
Project.

n

From the menu, select File>New>Taxonomy Project.

n

Press Alt+Shift+N, and then press R, to open the Select a Wizard window. Then select HP
Systinet>Taxonomy Project.

to open the Select a Wizard window, and select HP Systinet>Taxonomy

The New Taxonomy Project dialog box opens.
2. In the New Taxonomy Project dialog box, enter the following parameters:
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Parameter

Definition

Project
Name

The name of your assertion project.

Taxonomy
ID Prefix

The URN prefix to apply to all taxonomies in the project.

Create from
Existing
Extension

Select this option if you want to create a new project from a previous
taxonomy extension. If selected, input the path or browse for the location of
the taxonomyn extension.

Use Default
Location

If selected, Taxonomy Editor stores the project in your default workspace. If
unselected, input the path or browse for an alternative workspace.

3. Click Next to select or create a server.
Note: If no servers are currently defined, the dialog box continues to "Creating a Taxonomy
Project" (on page 21).
4. Do one of the following:
n

Select Create a New Server, and click Next.
Continue to "Creating a Taxonomy Project" (on page 21).

n

Select Use an Existing Server, select the server from the list and input its credentials, and
then click Next.
Continue to "Creating a Taxonomy Project" (on page 21).

5. In the New Server dialog box, add the required parameters, and then click Next.
6. Select the taxonomies to download from the server. Optionally, select Show System
Taxonomies to view system taxonomies for selection.
7. Click Finish.

Customizing Taxonomy Editor
Some settings are customizable in Taxonomy Editor.
To Change Taxonomy Editor Preferences:
1. Select Window>Preferences.
The Preferences dialog box opens.
2. In the tree menu, select HP Systinet>Taxonomy Editor.
3. You can change the following:
n

Default taxonomy namespace
The default namespace setting is 5.5. However, version 5.5 taxonomies cannot be used in
HP SOA Registry Foundation 5.0. Make sure you select the appropriate setting.

n

Data consistency
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Select Validate before publishing taxonomies to validate changes before publishing
them to the server

Downloading Taxonomies from a Server
Initially, Taxonomy Editor does not contain any taxonomies. To edit Systinet taxonomies, you must
download them from a server.
To Download Taxonomies from a Server:
1. In Server Explorer, right-click the server containing the taxonomies you need to open its
context menu, and select Download Taxonomies.
The Download Taxonomies wizard opens.
2. Select the taxonomies to download and click Next.
The Choose Location dialog box opens.
3. Select the project to add the taxonomies to, and then click Finish.
Taxonomy Editor displays the download progress. When the download is complete, the taxonomies
are visible in Project Explorer.

Searching for Taxonomies
This section describes the search facilities provided by Taxonomy Editor.
Quick Find is the easiest way to find a taxonomy.
To use Quick Find:
1. Do one of the following:
n

Click Search, and then select Quick Jump.

n

Press Ctrl+J.

The Find Taxonomy dialog box opens. For details, see "Find Taxonomy Dialog" (on page 44).
2. In the input field, enter a search string.
3. Click View Menu
n

, and then select one of the following options:

Show in the tree without opening detail
Shows the taxonomy in the tree but does not open its details page.

n

Case-sensitive
Enables a case-sensitive or case-insensitive search.

4. In the in project field, select in which project to search for the taxonomy.
Taxonomies that match your search criteria are displayed in the Matching taxonomies pane.
5. Select the required taxonomy and click Open taxonomy.
The taxonomy opens in the Editor pane.
For a more detailed search, you can use Advanced Search to do the following:
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l

Search for a specific property type.

l

Search according to a specific value of a property.

l

Search different text strings: full text, regular expression, or whole word.

To Use Advanced Search:
1. Do one of the following:
n

Select Search>Search.

n

Press Ctrl+H.

The Search dialog box opens.
2. Select the Taxonomy Search tab to open the dialog box. For details, see "Search Taxonomy
Dialog" (on page 45).
3. In the Containing text field, do one of the following:
n

Enter the text to search.

n

Select text used in a previous search by using the drop-down list.

4. In Search only in, choose the taxonomy properties or categories to search.
5. In Search controls, select one or more of the following:
n

Case-sensitive
To perform a case-sensitive search.

n

Whole words only
To search for whole word matches.

n

Regular expression
To search using regular expressions.

6. In Scope, select one of the following:
n

Workspace
To search the Eclipse workspace.

n

Selected resources
To search all entities selected in Project Explorer.

n

Working set
To customized resources from Project Explorer.

7. Click Choose.
The Select Working Sets wizard opens.
Do one of the following:
n

Select from existing working sets.

n

Create new working sets.
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8. Click Search.
The results are displayed in the Search view of the UI.
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Managing Taxonomies
This chapter describes how to work with taxonomies, as detailed in the following sections:
l

"Creating Taxonomies" (on page 26)

l

"Editing Taxonomies" (on page 26)

l

"Editing Categories" (on page 27)

l

"Deleting and Restoring Taxonomies" (on page 29)

l

"Comparing Taxonomy Files" (on page 30)

l

"Updating Taxonomies from the Server" (on page 30)

l

"Importing and Exporting Taxonomy Files" (on page 30)

Creating Taxonomies
In "Creating a Taxonomy Project" (on page 21), you created a Taxonomy Project and looked at how
to download taxonomies. The following section describes how to create new taxonomies.
To Create a New Taxonomy:
1. Do one of the following:
n

Click New
to open the Select a Wizard dialog box, and select HP
Systinet>Taxonomy, and then click Next.

n

Select File>New>Taxonomy.

n

Press Alt+Shift+N to open the context menu, and then select Taxonomy.
The New Taxonomy wizard opens.

2. In the New Taxonomy wizard, enter the required parameters.
Note: A default Taxonomy ID and Filename are assigned according to the Taxonomy Name
entered. The Source Folder is assigned by default, according to whether there is an
active extension project. You can change these parameters to meet your requirements.
3. Click Finish to create the taxonomy.
The taxonomy is now visible in Project Explorer and the Taxonomy Editor opens.
4. Open the Categories tab and add the categories you need. For details, see "Editing
Categories" (on page 27).
5. Open the Advanced tab and enter the required parameters, as described in "Editor View" (on
page 14).

Editing Taxonomies
A taxonomy can be modified in the following ways:
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l

"Editing Taxonomy Properties" (on page 27)

l

"Refreshing Taxonomies to Reflect External Changes" (on page 27)

l

"Copying Taxonomies" (on page 27)

Editing Taxonomy Properties
To Edit Taxonomy Properties:
1. Double-click the taxonomy in Project Explorer to open the Editor view.
2. Edit properties as required in the tabs of the Editor view. For details, see "Editor View" (on page
14).
3. Click Save.
The changed status of the taxonomy is displayed in Project Explorer.

Refreshing Taxonomies to Reflect External Changes
If you want the Editor to reflect changes made outside Taxonomy Editor, you can refresh the
taxonomy.
To refresh a taxonomy, do one of the following:
l

Right-click the individual taxonomies or the project in Project Explorer to open the context menu,
and then select Refresh.

l

Select the individual taxonomies or the project in Project Explorer, and then press F5.

The selected taxonomies are then updated to reflect external changes.

Copying Taxonomies
You can copy or move taxonomies from one project to another using cut, copy, or paste.
To Copy or Move a Taxonomy to a Different Project:
1. Right-click the taxonomy in Project Explorer and select Copy or Cut.
2. Right-click the project to which you want to copy or move the taxonomies and select Paste.
The taxonomies are then either copied or moved to the other project.
A pasted taxonomy has the status:
l

New
If a taxonomy of that name is new to that location.

l

Modified
If an existing taxonomy is overwritten.

Editing Categories
A taxonomy can be modified in the following ways:
l

"Adding a Category" (on page 28)

l

"Removing a Category" (on page 28)
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l

"Copying a Category" (on page 28)

l

"Moving a Category" (on page 29)

Adding a Category
To Add a New Category to a Taxonomy:
1. Open the required taxonomy in the Editor pane and click the Categories tab.
2. Do one of the following:
n

Click Add Next to add a new category at the same level.

n

Click Add Child to add a new sub-category.

The New Category wizard opens.
3. Enter the category properties, as follows:
n

Name
Name for the category. This represents the value of the keyName attribute in the
taxonomy's XML representation.

n

Value
Identifier for the category. This represents the value of the keyValue attribute in the
taxonomy's XML representation.

n

Disabled
Select this check box to make sure the category cannot be used in an artifact.

4. Click Finish.
The new category is displayed in Category Structure.

Removing a Category
To Remove a Category:
1. Open the required taxonomy in the Editor pane and click the Categories tab.
2. Right-click the category in the Category Structure pane to open its context menu, and select
Delete.
The deleted category is no longer visible in the Category Structure pane.

Copying a Category
To Copy a Category:
1. Open the required taxonomy in the Editor pane and click the Categories tab.
2. Right-click the required source category in the Category Structure pane to open its context
menu, and then select Copy or Cut.
3. Right-click the required destination category in the Category Structure pane to open its context
menu.
4. Do one of the following:
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n

Select Paste to add the category as a sub-category.

n

Select Paste as Sibling to add the category at the same level.

Moving a Category
To Move a Category:
1. Open the required taxonomy in the Editor pane and click the Categories tab.
2. Select the required category in the Category Structure pane.
3. Do one of the following:
n

Click Up, to move a category up.

n

Click Down, to move a category down.

n

Click Unindent, to move a category to the left.

n

Click Indent, to move a category to the right.

Note: To move multiple categories at the same time, you must select categories that are
consecutive.

Deleting and Restoring Taxonomies
You can also delete taxonomies and restore them from your local history.
To Delete a Local Taxonomy:
1. Right-click the taxonomy in Project Explorer to open its context menu, and then select Delete.
2. Confirm deletion of the taxonomy when prompted.
To Restore a Deleted Taxonomy:
1. Right-click the project in Project Explorer to open its context menu and select Restore from
Local History.
The Restore from Local History dialog box opens.
2. Select the check box of the required taxonomy and click Restore.
3. Download the published taxonomy from the server, as described in “Downloading Taxonomies
from a Server”.
To Delete a Taxonomy from the Server:
1. Right-click the taxonomy in Project Explorer to open its context menu and select HP
Systinet>Remove from Server.
2. Choose if you also want to delete the local copy.
3. Confirm deletion of the taxonomy when prompted.
Note: Taxonomy Editor automatically performs a data consistency check before removing the
taxonomy from the server. For details, see “Conflict With Server”.
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Comparing Taxonomy Files
If you are importing or exporting taxonomies between servers, it is essential to compare
taxonomies to keep track of changes.
Taxonomy Editor enables you to compare the following taxonomies:
l

Local taxonomy against the server taxonomy.

l

Server taxonomy against a local history taxonomy.

To Compare Taxonomies:
Right-click the taxonomies you want to compare in Project Explorer to open a context menu, and
then select one of the following:
l

Compare With>Each Other

l

HP Systinet>Compare with the latest on server

l

Compare With>Local History

The results are displayed in the Compare view.

Updating Taxonomies from the Server
If the most current version of a taxonomy exists on a server, you can update your local copy to
reflect any changes.
To Update a Local Taxonomy:
l

Right-click the taxonomy in Project Explorer to open the context menu, and then select HP
Systinet>Update from Server.
Note: Confirmation is required to overwrite existing taxonomies.

Importing and Exporting Taxonomy Files
You can import and export taxonomies between your projects and your local file system.
To Import a Taxonomy from your File System:
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1. In Project Explorer, right-click the taxonomy project to which you want to import taxonomies to
open its context menu, and then select Import>Taxonomy.
The Import Taxonomies wizard opens. For details, see "Import Taxonomies" (on page 42).
2. Browse for the folder from which you want to export taxonomies in the Folder field.
The selected folder is displayed in the left pane.
3. Click the check box of the chosen folder.
Compatible file types are displayed in the right pane.
4. Click the check box of the files you want to import and, and then browse for the required import
folder in the Into folder field.
5. Click Finish.
6. Publish the taxonomies to an Systinet repository, as described in "Publishing Taxonomies" (on
page 32).
Tip: When importing a taxonomy from a file whose file name already exists in the local folder,
Taxonomy Editor asks if you want to overwrite the taxonomy. If you click Yes or Yes To All,
the current taxonomy is updated by attributes and categories from the XML file and its status is
changed to modified.
To Export a Taxonomy:
1. Right-click the taxonomy in Project Explorer to open its context menu, and then select Export
to open the Export wizard. For details, see "Export Taxonomies Wizard" (on page 42).
2. Select the required file type and click Next to open the corresponding wizard.
3. Browse for the required destination and enter the required parameters.
4. Select whether to overwrite existing files.
5. Click Finish.
Note: You can export a taxonomy to any file type supported by Eclipse. For example:
l

XML file

l

JAR archive

l

EAR-deployable or JAR-deployable archive

Page 31 of 49

HP SOA Systinet Workbench (4.03)

Chapter 4
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This chapter explains how to deploy a set of taxonomies as an Extension Project.
You can publish individual taxonomies as described in "Publishing Taxonomies" (on page 32).
Alternatively, create a taxonomy extension and deploy it as described in the following sections:
l

"Building a Taxonomy Extension" (on page 32)

l

"Applying Extensions" (on page 33)

l

"Redeploying the EAR File" (on page 36)

Publishing Taxonomies
Publishing is the process of updating changes to an Systinet server.
To Publish a Taxonomy:
l

Right-click the taxonomy in the Project Explorer to open its context menu, and then select HP
Systinet>Upload to Server. Multiple taxonomies may be selected by holding CTRL and
selecting them.
The taxonomy is published to the defined Systinet server.

Caution: You cannot publish a System taxonomy to a remote repository.
The status of a taxonomy after publishing updates as described in the following table.

Taxonomy Status After Publication
Status

Description

Impact

UP-TODATE

Local and server versions are
identical.

Publication was successful, including any
modifications.

NEW ?

Local version of the taxonomy has not
been published to the server.

Publication was unsuccessful and the
status is unchanged. Possibly due to one
of the following:

MODIFIED
>

Changes have been made to a local
version of a taxonomy after it has
been published.

SYSTEM

Taxonomies automatically generated
by Systinet. For system use only.

l

Exception error.

l

Breach of server data integrity.

Changes to these taxonomies cannot be
published.

Building a Taxonomy Extension
After publishing taxonomies, you can create a Taxonomy Extension.
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To Build a Taxonomy Extension:
1. Right-click the taxonomy project in Project Explorer to open its context menu, and expand HP
Systinet>Build Extension to open the location browser.
2. Enter a name for the extension project and browse for the location you want to save the project
to, and click Save.
All taxonomies from the selected taxonomy project are copied to the Taxonomy Extension.

Applying Extensions
You can extend HP Systinet by adding libraries or JSPs to the deployed EAR files, by modifying
the data model, by configuring the appearance of the UI, and by importing prepackaged data.
Extensions to HP Systinet come from the following sources:
l

Customization Editor
Typical extensions created by Customization Editor contain modifications to the data model,
and possibly data required by the customization (taxonomies). They may also contain new web
components, which may include custom JSP and Java code.
Caution: If your extension contains new artifact types, HP Systinet does not create default
ACLs for them. Set default ACLs for the new artifact types in HP Systinet using the
functionality described in "How to Manage Default Access Rights" in the HP Systinet
Administration Guide.

l

Assertion Editor, Report Editor, and Taxonomy Editor
These extensions contain assertion, reporting, and taxonomy data only. They do not involve
changes to the data model.

The Setup Tool opens the EAR files, applies the extensions, and then repacks the EAR files.
Apply extensions according to one of the following scenarios:
l

Single-Step Scenario
The Setup Tool performs all the processes involved in applying extensions, including any
database alterations, as a single step.
Follow this scenario if you have permission to alter the database used for HP Systinet.
To Apply Extensions to HP Systinet in a Single Step:
a. Make sure that all extensions are in the following directory:
SOA_HOME/extensions
The Setup Tool automatically applies all extensions in that directory.
Note: If you are applying extensions to another server, substitute the relevant home
directory for SOA_HOME.
b. Stop the server.
c. Start the Setup Tool by executing the following command:
SOA_HOME/bin/setup.bat(sh)
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d. Select the Apply Extensions scenario, and click Next.
The Setup Tool automatically validates the step by connecting to the server, copying the
extensions, and merging the SDM configuration.
e. Click Next for each of the validation steps and the setup execution.
Note: This process takes some time.
f. Click Finish to end the process.
g. Deploy the EAR file:
o

JBoss
The Setup Tool deploys the EAR file automatically.
If you need to deploy the EAR file to JBoss manually, see "Redeploying the EAR File"
(on page 36).

o

Other Application Servers
You must deploy the EAR file manually.
For application server-specific details, see "Deploying the EAR File" in the Installation
and Deployment Guide.

h. Restart the server.
Caution: Applying an extension that modifies the SDM model may drop your full text indices.
SOA_HOME/log/setup.log contains the following line in these cases:
Could not apply alteration scripts, application will continue with
slower DB drop/create/restore scenario. ... .
In these cases, reapply full text indices as described in the "Enabling Full Text Search" section
of the Installation and Deployment Guide.
l

Decoupled DB Scenario
Database SQL scripts are run manually. The Setup Tool performs the other processes as
individual steps that are executable on demand. This scenario is useful in organizations where
the user applying extensions does not have the right to alter the database, which is done by a
database administrator.
Follow this scenario if the user who applies extensions does not have permission to modify the
database.
To Apply Extensions and Modify the Database Separately:
a. Make sure that all extensions are in the following directory:
SOA_HOME/extensions
The Setup Tool automatically applies all extensions in that directory.
b. Stop the server.
c. Start the Setup Tool by executing the following command:
SOA_HOME/bin/setup -a
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d. Select the Apply Extensions scenario, and click Next.
e. Click Next, to execute the extension application, and exit the Setup Tool.
f. Provide the scripts from SOA_HOME/sql to the database administrator.
The database administrator can use all.sql to execute the scripts that drop and recreate
the database schema.
g. Execute the Setup Tool in command-line mode to finish the extension application:
SOA_HOME/bin/setup -c
h. Redeploy the EAR file:
o

JBoss
The Setup Tool deploys the EAR file automatically.
If you need to deploy the EAR file to JBoss manually, see "Redeploying the EAR File"
(on page 36).

o

Other Application Servers
You must deploy the EAR file manually.
For application server-specific details, see "Deploying the EAR File" in the Installation
and Deployment Guide.

Caution: In some specific circumstances (underscores and numbers in property names), extension
application may fail because HP Systinet cannot create short enough database table
names (31 character maximum for most databases).
The error in setup.log resembles the following:
[java] --- Nested Exception --[java] java.lang.RuntimeException: cannot reduce length of identifier
'ry_c_es_Artifact02s_c_priEspPty01Group_c_priEspPty01',
rename identifier elements or improve the squeezing algorithm
[java] at
com.systinet.platform.rdbms.design.decomposition.naming.impl.
BlizzardNameProviderImpl.getUniqueLimitedLengthName(
BlizzardNameProviderImpl.java:432)
[java] at
com.systinet.platform.rdbms.design.decomposition.naming.impl.
BlizzardNameProviderImpl.filterTableName(BlizzardNameProviderImpl.java:374)

This is due to HP Systinet using an older table naming algorithm in order to preserve backward
compatibility with HP SOA Systinet 3.00 and older versions.
If you do not require backwards compatibility with these older versions, you can change the table
naming algorithm.
To Change the Table Naming Algorithm:
1. Open SOA_HOME/lib/pl-repository-old.jar#METAINF/rdbPlatformContext.xml with a text editor.
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2. In the rdb-nameProvider bean element, edit the following property element:
<property name="platform250Compatible" value="false"/>
3. Save rdbPlatformContext.xml
This solution only impacts properties with multiple cardinality. If the problem persists or you need to
preserve backwards compatibility, then review the property naming conventions in your extension.

Redeploying the EAR File
After using the Setup Tool to apply extensions or updates, you must redeploy the EAR file to the
application server. For JBoss, you can do this using the Setup Tool.
Note: For other application servers, follow the EAR deployment procedures described in the
"Deploying the EAR File" in the Installation and Deployment Guide.
To Redeploy the EAR file to JBoss:
1. Stop the application server.
2. Start the Setup Tool by executing the following command:
SOA_HOME/bin/setup.bat(sh)
3. Select the Advanced scenario, and click Next.
4. Scroll down, select Deployment, and then click Next.
When the Setup Tool validates the existence of the JBoss Deployment folder, click Next.
5. Click Finish to close the Setup Tool.
6. Restart the application server.
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Conflicts and Validation Issues
Editing taxonomies can result in validation and conflict issues, as described in the following
sections:
l

"Local Validity" (on page 37)

l

"Server Conflicts" (on page 37)

l

"Repair Action" (on page 38)

Local Validity
By default, the validity of local taxonomies is constantly checked as you modify them.. Invalid
taxonomies are marked in Project Explorer and the associated errors are listed in the Problems
view. For example, errors for two taxonomies with the same ID can be seen in the following
screenshot.
Screenshot: Invalid Local Taxonomies

To disable validation, from the menu, deselect Build automatically.

Server Conflicts
A local taxonomy and the version on a server can come into conflict either when the version on the
server is changed or when changes to the local version affect artifacts on the server.
Conflicts are displayed when you try to publish the taxonomy. An error message is displayed,
stating that the taxonomy could not be published.
To help prevent conflicts, you can do the following:
l

Right-click the taxonomy in Project Explorer to open its context menu, and then select one of the
following:
n

HP Systinet>Show Taxonomy Usage
All artifacts categorized by the taxonomy are displayed in the Taxonomy Usage view.

n

Right-click the taxonomy in Project Explorer to open its context menu, and then select HP
Systinet>Validate Data Consistency
Conflicts are displayed in the Validation Results view.
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Screenshot: Validation Results

Repair Action
The Data Consistency Check reports artifacts that use categories which no longer exist in the
taxonomy project.
Taxonomy Editor features a Repair Action which enables you to resolve these inconsistencies.
To Repair an Inconsistency:
1. In the Validation Results view, expand the problem category, and right-click an artifact to open
its context menu, then select one of the following:
n

Remove Referenced Category From Artifact

n

Change Category

2. Re-run validation.
Note: Some conflicts relate to the validity of policy and lifecycle data (non-standard artifacts). The
repair actions cannot resolve these conflicts.
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Example: Creating and Publishing a Department
Taxonomy
In this example, you create and deploy a new taxonomy containing the identities of departments in
your organization.
Before proceeding, you must do the following:
l

Define your Systinet server.

l

Update the local taxonomies, as described in "Updating Taxonomies from the Server" (on page
30).

To Create a Department Taxonomy:
1. Create a new taxonomy, entering Departments as the Taxonomy Name.
For details of the procedure, see "Creating Taxonomies" (on page 26).
2. Open the Editor for the Departments taxonomy and select the Categories tab.
3. Add the following categories:
n

HR

n

IT

n

Payroll

n

Finance

n

Sales

n

Development

n

QA

For details of the procedure, see "Adding a Category" (on page 28).
4. Press Ctrl+S to save the taxonomy.
The Departments taxonomy is now visible in Project Explorer.
5. Right-click the Departments taxonomy to open its context menu, and then select one of the
following:
n

HP Systinet>Publish Taxonomy
To publish the taxonomy to the defined Systinet server.

n

HP Systinet>Publish To Other Server
To publish the taxonomy to a different server.

Page 39 of 49

HP SOA Systinet Workbench (4.03)

Appendix A
Keyboard Shortcuts
Shortcut

Action

Context

Ctrl+Alt+S

Add Systinet server.

Global

Ctrl+N

New taxonomy.

Global

Alt+A, Insert

Add next category.

Categories
tab

Alt+C

Add child category.

Categories
tab

Alt+U, Ctrl+ArrowUp

Move category up.

Categories
tab

Alt+D,
Ctrl+ArrowDown

Move category down.

Categories
tab

Alt+E, Ctrl+ArrowLeft

Move category left (unindent).

Categories
tab

Alt+I,
Ctrl+ArrowRight

Move category right (indent).

Categories
tab

F2

Navigate to Category Name field.

Categories
tab

Esc

Ignore changes in current test field and switch to
Category Structure

Categories
tab

Ctrl+PgDn

Switch to next editor tab.

Taxonomy
Editor

Ctrl+PgUp

Switch to previous editor tab.

Taxonomy
Editor

F12

Activate Editor.

Global

Ctrl+W, Ctrl+F4

Close current editor.

Global

Ctrl+Shift+W,
Ctrl+Shift+F4

Close all editors.

Global

Ctrl+F6

Go to next editor.

Global

Ctrl+Shift+F6

Go to previous editor.

Global

Ctrl+Shift+E

Switch to editor.

Global
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Shortcut

Action

Context

Ctrl+J

Quick find taxonomy.

Global

Ctrl+H

Search taxonomy or category.

Global

Alt+Shift+W

Show editing resource in Taxonomy Editor.

Global

F5

Refresh items.

Global

Ctrl+S

Save changes for active editor.

Global

Ctrl+Shift+S

Save changes for all editors.

Global

Ctrl+C, Ctrl+Insert

Copy

Global

Ctrl+X, Shift+Delete

Cut

Global

Delete

Delete

Global

Ctrl+V, shift+Insert

Paste

Global

Ctrl+Shift+L

Show key assist

Global
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Dialog Boxes Reference
Each Taxonomy Editor input dialog is described in the following sections:
l

"Import Taxonomies" (on page 42)

l

"Export Taxonomies Wizard" (on page 42)

l

"Find Taxonomy Dialog" (on page 44)

l

"Search Taxonomy Dialog" (on page 45)

Import Taxonomies
Select taxonomy files to import into your taxonomy project:

Parameter Definition
Folder

Browse for the source folder containing the taxonomy files you want to import.

Left Pane

Select the source folder containing the taxonomy files you want to import.

Right
Pane

Select the individual taxonomy files you want to import.

Into Folder Browse for the destination folder into which you want to import the selected
taxonomies.

Export Taxonomies Wizard
Select a destination for the taxonomies you wish to export:
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Parameter

Definition

Select an export destination Enter text to filter your search.
Tree View

Select File System as your destination folder.

Select the taxonomies you want to export, then browse for the destination directory:
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Parameter

Definition

Left Pane

Select the project from which you want to export taxonomies.

Right Pane Select the individual taxonomies you want to export.
To
Directory

Browse for and select the directory into which you want to export the selected
taxonomies.

Find Taxonomy Dialog
A quick search for matching taxonomies:
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Parameter

Definition

Top Field

Enter text to filter your search results.

Matching Taxonomies

A list of taxonomies matching your search request.

In Project

Select the project in which you want to search for taxonomies.

Search Taxonomy Dialog
An advanced search for matching taxonomies:
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Parameter

Definition

Containing
Text

Enter text to search or use the drop-down menu to select a previous search
parameter.

Working Set

Browse for and select a working set as a scope for your search.
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Troubleshooting
Case

Indications

Resolution

Type

Severity

A taxonomy
was changed
on the remote
server while
you were
modifying your
local version.

Your local taxonomy is
CONFLICTING. The
local version cannot be
published and its
modifications are kept.

To replace the local
taxonomy with the server
version, use the taxonomy
context action HP
Systinet>Update
Taxonomy. You might
want to first copy your
local version to a
temporary location.

Conflict

Error

A taxonomy
was published
that has the
same file name
as a new
taxonomy you
are trying to
publish to the
remote server.

Taxonomy is
CONFLICTING. The
local version cannot be
published. Changes to
the local taxonomy and
server remain in Project
Explorer.

To replace the local
taxonomy with the remote
server version, use the
taxonomy context action
HP Systinet>Update
Taxonomy. You might
want to first make a
backup copy your local
version.

Conflict

Error

The taxonomy
you have
created has the
same ID as an
existing
taxonomy on
the remote
server

The local taxonomy
cannot be published.
Changes to the local
taxonomy and server
remain in Project
Explorer. The
Validation Results
include a node giving
the taxonomy ID.

Change the ID of the new
taxonomy.

Validation
Results

Error

You have
changed the ID
of a taxonomy
used by
artifacts.

The local taxonomy
cannot be published
and remains
MODIFIED. The
Validation Results list
artifacts that use the
taxonomy.

To restore the original
taxonomy, use the
taxonomy context action
HP Systinet>Update
Taxonomy.

Validation
Results

Error

A category that
you modified is
used by other
artifacts.

The local taxonomy
cannot be published
and remains
MODIFIED. Validation
Results lists artifacts
that use the category.

To restore the original
taxonomy, use the
taxonomy context action
HP Systinet>Update
Taxonomy.

Validation
Results

Error
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Case

Indications

Resolution

Type

Severity

A new
taxonomy ID is
identical to that
of another local
taxonomy.

An error message for
this taxonomy is
shown.

Change taxonomy ID to
another value.

Local
Inconsistency

Error

Taxonomy ID
format is
invalid.

A warning message for
this taxonomy is
shown.

Change taxonomy ID to
valid format.

Local
Inconsistency

Warning

Category value
is duplicated by
another
category in the
same
taxonomy.

An error message for
this taxonomy is
shown.

Change the category
value.

Local
Inconsistency

Error

Taxonomy file
name contains
invalid
character for
REST URL.

An error message for
this taxonomy is
shown.

Change file name so that it Local
does not contain invalid
Inconsistency
character.

Error
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Appendix D
Eclipse Plug-in Requirements
Ensure that the following prerequisite plug-ins are added to your Eclipse development platform
based on the required Workbench components:
l

DTP 1.6
Required for Customization Editor and Report Editor.
http://www.eclipse.org/datatools/downloads.php

l

EMF Runtime 2.4.0
Required for Customization Editor and Report Editor.
http://www.eclipse.org/modeling/emf/downloads/?project=emf

l

GEF Runtime 3.4
Required for Customization Editor and Report Editor.
http://archive.eclipse.org/tools/gef/downloads/drops/R-3.4.0-200806091334/

l

WTP 3.0
Required for Customization Editor and Report Editor.
http://archive.eclipse.org/webtools/downloads/drops/R3.0/R-3.0-20080616152118/

l

XSD Runtime 2.4
Required for Customization Editor and Report Editor
http://www.eclipse.org/modeling/mdt/downloads/?project=xsd

l

BIRT 2.2.0
Required for Report Editor.
http://download.eclipse.org/birt/downloads/build_list.php
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